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Put ( √ ) or ( X ) 

1 Ms. Sonika Manandhar is a gaming technology entrepreneur. (        ) 

2 Ms. Sonika Manandhar is a National Geographic Explorer from 

the Republic of Congo 

(        ) 

3 Ms. Sonika Manandhar is known as one of the leading scientists 

in the educational gaming industry. 

(        ) 

4  Singularity University is affiliated with NASA in California. (        ) 

5 Ms. Manandhar wanted to use her knowledge to improve the 

local environment in Nepal. 

(        ) 

6  Increasing the amount of carbon emissions helps to improve the 

local and natural environment. 

(        ) 

7 The use of electric buses can reduce the rate of carbon 

emissions. 

(        ) 

8 Most of the bus drivers in Kathmandu are young people. (        ) 

9 Ms. Sonika Manandhar worked for the fintech company Aloi 

without co-founding it.  

(        ) 

10 Aloi helps people use financial services. (        ) 

11 Women drivers in Nepal can modernize their old buses by 

taking out loans from Aloy. 

(        ) 

12 The buses can be modernized with water-based batteries so that 

they last longer. 

(        ) 

 

Lesson 1 Explorer in action 
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13 Drivers can only repay their loans hand in hand. (        ) 

14 Aloi's loan process is faster and easier than most current bank 

loan processes. 

(        ) 

15 Only when the loan is approved can the driver receive a digital 

code that she can use with authorized vendors. 

(        ) 

16 The driver must pay all her debts to the mall at once from the 

profits in the month following the purchase. 

(        ) 

17 The driver can follow up on all her transactions through text 

messages without having to use the internet. 

(        ) 

18 The platform has nothing to do with the financiers' business as 

it cannot report on how the loans are spent. 

(        ) 

19 Passengers can schedule their trips through the company's 

website. 

(        ) 

20 Passengers can complete their financial transactions using 

digital tokens or mobile wallets. 

(        ) 

21 Egypt has not contributed to environmental conservation 

activities or any environmental conferences. 

(        ) 

22 Egypt has launched the first home-made electric car in the 

framework of adopting a green economy. 

(        ) 

23 The locally-made electric car launched by Egypt can 

accommodate 9 people and travel at a maximum speed   

(        ) 

24 Ms. Sonika Manandhar uses her Instagram account to spread 

awareness of the benefits of small green business owners 

(        ) 
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Choose the correct answer:  

1-Ms. Sonika Manandhar is a .................... technology entrepreneur   

A. Financial                      B. space.                     C. Engineering 

equipment.   

2- Ms. Sonika Manandhar is a National Geographic explorer from the 

Republic of .................. 

A - Nepal                B - Dominican Republic            C - China 

3- "Sonika Manandhar" was interested in the field of ...................... 

A - Art                    B - Engineering                          C - Medicine 

4- She studied ....................... robotics and artificial intelligence at Singularity 

University. 

A- Big Kenner                    B- Mojos                        C- Sonika Manandhar 

5- NASA's Singularity University is located in ...................   

A- California                      B- Egypt                          C- France 

6- Sonika Manandhar wanted to utilize her knowledge of ............. the local 

environment by minimizing the rate of carbon emissions 

A-  improving                       B-  Destroy                       C- Optimize   

7- Sonika Manandhar noted that using ...............              may reduce the rate 

of carbon emissions. 

A- Electric minibuses      B- Coal minibuses        C- Natural gas trains    

Sonika Manandhar noticed that most of the car drivers in Nepal's capital 

................. are women. 

A. California                   B- Singularity                  C. Kathmandu 
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9- In 2019, Ms. Manandhar co-founded the fintech company ................. 

A- Amazon                       B- Aloi                             C- Google 

10 - Aloi helps women minibus drivers in Nepal access ................ low-interest 

loans. 

a. Loans                             b. Prizes                                    c. Rewards 

11- Aloi helps improve the environment by helping electric bus drivers to 

 purchase and modernize buses by providing them with long-lasting 

.................. 

a-Tools and equipment     b. Natural gases       c. Lithium-ion batteries 

12. Electric bus drivers receive and repay bank loans through ...................  

a. Direct bank transactions          b. Company platform            c. Mailboxes 

13- The electric bus driver receives .............. upon loan approval which she 

uses when dealing with authorized suppliers. 

a. Loan                         b. Card                                c. Digital code  

14- The electric bus driver repays her debt to the financier ................ from the 

profits she makes from her business. 

a. Monthly                   b. Daily                                 c. Yearly  

15- All financial transactions when purchasing electric buses are done 

through ................. 

a. Text messages                b. Whatsapp messages                  c. Emails  

16-It is .................. for Passengers to schedule their trips through the 

company's website. 

A. Impossible                 B. Possible                 C. Not available 
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17- Passengers can pay for the flight using digital tokens or ................ mobile 

phone. 

a. wallet                      b. whatsapp on                   C. Photo App 

18- As part of Egypt's adoption of green economy strategies, it launched the 

first .................. homemade. 

A - electric trains                   B – airplanes                         C - electric cars 

19- The electric car launched by Egypt to preserve the environment can 

accommodate nine people and travel at a maximum speed of .......... 

kilometers / hour. 

A- 60                         B- 90                                      C- 120 

20- The price of the electric car launched by Egypt is expected to be 

.................. for the Egyptian market. 

A- Unsuitable                    B- Unacceptable                          C- Suitable                                                               

 

 

Put ( √ ) or ( X ) 

1 The operating system (OS) manages computer functions and 

runs programs and hardware. 

(        ) 

2 The operating system is of no importance to your computer  (        ) 

3 The operating system allows the user to communicate with the 

computer easily. 

(        ) 

Lesson 2 Operating systems and software 
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4  The operating system coordinates and manages the 

communication between your hardware and software. 

(        ) 

5 The operating system has nothing to do with the requirements 

of different computer programs. 

(        ) 

6  Your computer will not be able to function without the 

operating system. 

(        ) 

7 The CPU, memory, and storage are components of a computer. (        ) 

8 A new operating system must be installed on the computer when 

you buy it because it is not supplied with it. 

(        ) 

9 Microsoft Windows is often used in schools on computers.  (        ) 

10 Macintosh computers use the macOS operating system. (        ) 

11 macOS is generally inexpensive as schools use it. (        ) 

12 Smartphones and tablets use Microsoft Windows operating 

systems. 

(        ) 

13 You can change operating system settings using the System 

Settings control. 

(        ) 

14 All operating system settings have the same names and 

appearances. 

(        ) 

15 In mac OS, the settings are called System Preferences. (        ) 

16 The settings in IOS are called Control Panel. (        ) 

17 Hardware or software settings in the Control Panel cannot be 

modified. 

(        ) 

18 You can add a new wireless printer to your computer, but it 

cannot be removed from your computer. 

(        ) 
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19 Changes you make in Control Panel are automatically applied 

to other programs on your computer. 

(        ) 

20 Some programs are automatically downloaded and allowed to 

be used immediately. 

(        ) 

21 To remove a program from your Windows machine, open 

Control Panel and then remove the program directly without 

following specific steps. 

(        ) 

22 Programs installed on Android devices cannot be removed. (        ) 

23 The operating system is an essential part of the programs on 

computers. 

(        ) 

Choose the correct answer:  

1-The operating system manages ....................  computer functions, running 

programs and hardware.   

a- os.                           b- mac.                                                    c- macintosh 

2- The most important program on your computer is .................. 

a. Word                      b. Operating system                             c. Paint 

3- The operating system coordinates communication between your devices 

and ......................... 

a. your friends                  b. your contacts                        c. your programs 

4- Most computers and laptops have a pre-loaded operating system 

................... 

a- Microsoft Windows               b- macOS                                     c- IOS   
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5- Smartphones and tablets use different operating systems such as Android 

and ...................   

a- Microsoft Windows                 b- macOS                               c- IOS   

6- You can change the operating system settings using the ......................... 

control 

a. Self              b. Selecting travel modes                 c. System Settings 

7- System settings have several different names and appearances depending 

on the ................. you are using. 

a- Operating system          b- Phone type             c- Device manufacturer 

8- Device settings in iOS are called ..................... 

A - Control Panel            B - Control Center         C - System Preferences 

9- You can locate ................ by typing Control Panel in the search box in the 

taskbar. 

a. Control Panel             c. PowerPoint                    d. Google 

10- To add a new wireless printer, select Hardware & Sound, then ............., 

then select the printer you want after the device searches for it. 

a. Clear data             b. Delete device                    c. Add device 

11. Changes you make in the Control Panel ............... are applied to other 

programs on your computer 

a. Manually            b. Automatically            c. With a specific physical tool   

12. You can drag and drop the font file you want from the font library 

installed on your computer located in .............  

a. Downloads folder           b. Hardware and Sound         c. Media and Printers 
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13. Programmers try to improve the graphical interface of the control panel 

with each version of Windows that comes out with ................. 

A. An updated operating system                           B. The same operating system 

C. A type of computer  

14- When you connect a new printer to a computer, ..................... downloads 

the appropriate software so you can use it right away. 

a- Windows                                    b- macOS                              c- IOS 

15- You can ....................... the program by clicking the right mouse button 

and then uninstalling 

a. Put                              b. Add                                           c. Delete  

16- To uninstall a program from .................., you can open the App Store, click 

on the profile icon, then click on Manage Applications and Devices, then 

Manage, hold down the name of the application you want to remove, then 

click on Uninstall. 

A- Android                                 B- Windows                             C- Microsoft 

 

 

Put ( √ ) or ( X ) 

1 Microsoft Word is by far the most reliable tool for writing 

reports and sharing information. 

(        ) 

2 You can write reports using the Microsoft Access application 

and use its various tools  

(        ) 

3 To choose a specific layout, click on the Layout and Input tabs. (        ) 

Lesson 3 Writing and sharing reports 
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4  Microsoft Word includes formatting tools that allow the user to 

print text in italic or bold formats. 

(        ) 

5 Microsoft Word tools do not allow you to put headings or create 

tables. 

(        ) 

6  Some of the tasks that Microsoft Word tools can perform are 

inserting images, hyperlinks, and footnotes. 

(        ) 

7 Previewing the initial document before saving or printing it is 

allowed in Microsoft Word. 

(        ) 

8 WhatsApp is a messaging service for exchanging ideas and 

sharing information. 

(        ) 

9 WhatsApp does not help in providing feedback, especially when 

working on a group project.  

(        ) 

10 Text messaging does not allow you to send audio and video 

messages and images. 

(        ) 

11 Text messages or photos can only be sent via WhatsApp to one 

person. 

(        ) 

12 WhatsApp is a very expensive service to use. (        ) 

 

13 Encrypting messages sent in WhatsApp is one of the good 

features of the application. 

(        ) 

14 WhatsApp services can be used from any device and without 

being restricted to a location. 

(        ) 

15 You can use the design elements in Microsoft Word to increase 

the professionalism of your report  

(        ) 
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Choose the correct answer: .    

1.Reports can be written using Microsoft………………   

a-Excel.                       b. PowerPoint.                                  c. Word 

2.To choose a specific layout, you can click on ............... and enter 

a. Layout                    b. Home page                                 c. References 

3.Microsoft's ................. program includes the ability to print italicized or 

capitalized words 

a. Word                       b. Access                          c. PowerPoint 

4.............. is one of Microsoft Word's formatting tools  

a. Footnotes                   b. Drawing                       c. Adding slides 

5.You can use messaging services such as .....................   

a. WhatsApp                   b. Excel                             c. Word   

6.Feedback from colleagues and teachers can be requested through ................ 

 a. WhatsApp                   b. Photos                          c. System Settings 

7.WhatsApp messages allow sending messages................. in a single 

conversation 

a. Individual                      b. Group                        c. Individual and group 

8.WhatsApp messages are characterized as .................... . 

a. Free                               b. Expensive                    c. Moderately priced 

9.No one but the recipient of the message can read it, a feature of WhatsApp 

called ................. 

a. Non-privacy                 b. Encryption                    c. Violations 
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10.WhatsApp messaging services can be used on an Android or Apple               

device ............. 

a. Unlimited                  b. Time-limited                    c. At a higher cost    

 

Put ( √ ) or ( X ) 

1 You can use office programs and create presentations to express 

your opinions and ideas. 

(        ) 

2 Make your presentations interesting and engaging by using the 

right design.  

(        ) 

3 Microsoft PowerPoint is a text editing application only. (        ) 

4  Animation options are available to add motion to the sentences 

and words on the slides. 

(        ) 

5 Microsoft PowerPoint does not help to create presentations in 

which you can express your ideas.  

(        ) 

6  All Microsoft PowerPoint tools are complex and require special 

skills. 

(        ) 

7 You can effectively communicate your idea by using the tools to 

create engaging visuals that will grab the attention of your 

viewers. 

(        ) 

8 You can review your presentation through the editing tab in 

review mode. 

(        ) 

Lesson 4 Creating  a presentation 
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9 You can save the file and maintain its format by saving it in 

Word.  

(        ) 

10 PowerPoint does not offer the option to customize the slide size. (        ) 

11 The tools in the Design tab help attributes and variables to 

choose the style of your presentation. 

(        ) 

12 The Insert tab allows you to add an image, shape, or text box. (        ) 

 

13 Images can be loaded from files on the computer only when an 

image is inserted into the presentation. 

(        ) 

14 You can preview the presentation for the last time by pressing 

the Print button. 

(        ) 

15 The PowerPoint presentation should not exceed 10 slides and 20 

minutes and should not use a font type smaller than 30 points  

(        ) 

Choose the correct answer:  

1- You can create presentations through the Microsoft program ........................   

a- Word.                       b - PowerPoint.                      c - Access 

2- Using the right ............ makes presentations more interesting and 

attractive. 

a. Design                       b. Device                                 c. Mouse 

3- Microsoft PowerPoint includes tools .............. and writing for drafting texts. 

a - Maintenance               b - Engineering                  c – Drawing 
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4- Options are available ..................... to add movement to sentences and 

words on slides 

a - do not allow                     b – prohibit                      c- allow 

5- PowerPoint includes tools .................... that help users create engaging 

materials for viewers. 

a. Difficult                              b. Complex                       c. Easy  

6- To save the file before printing to preserve its formatting, click on ............. 

a- Save the file as - pdf option           b- Delete the file           c- Layout 

7- You can review the presentation and make changes in review mode by 

clicking on ................... 

a- Insert an image             b- Edit in review mode            c- Add a table 

8- The slide size is chosen by clicking on the ........................ tab. 

a- Input- Text box          b- Type size             c- Design- Slide size 

9- The style and position of the text can be changed by clicking on .................... 

a- Insert                         b- Design- Themes                  c- File 

10- When writing the message on PowerPoint, you must observe the rule of 

................ when it comes to text size 

a- 10/20/30                    b- Security                                c- Device 

11- The number 10 in the 10/20/30 rule refers to ...................... 

a. Presentation time          b. Number of slides                c. Font size 

12- The number 20 in the 10/20/30 rule refers to ...................... 

a. Number of slides          b. Font size                c. Display time   
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13- The number 30 in the 10/20/30/30 rule refers to the lowest ......................  

a- Font size              b- Display time                    c- Number of slides 

14- Images can be added by clicking on the ...................... tab 

a- Insert Image                  b- File- Print              c- Insert Text Box   

15- You can print the file by clicking on .................... 

a- File- Print                       b- Insert                      +c- Design 

 

Put ( √ ) or ( X ) 

1 To be able to analyze your results and make decisions, you need 

to organize the information you collect about an issue. 

(        ) 

2 All data must be managed in compliance with European data 

protection laws  

(        ) 

3 Databases store a limited amount of data and information in a 

computer system  

(        ) 

4  Data can be easily analyzed or changed to meet the needs of 

users. 

(        ) 

5 A database does not allow the collection of data or information 

about people or places. 

(        ) 

6  Teachers can use databases to collect information about their 

students. 

(        ) 

7 Companies use databases to record information about their 

employees. 

(        ) 

Lesson 5 Creating a database 
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8 Microsoft Word is used to create a database. (        ) 

9 To type the column headings and field names to be added, click 

Class Name    

(        ) 

10 ID Number is used to type the correct identification number. (        ) 

11 To add a column to a database, right-click and choose Insert 

Column. 

(        ) 

12 Type the class name in the Class Name column. (        ) 

 

13 Excel automatically formats numbers and dates as you type 

them. 

(        ) 

14 Some common Excel tools include coloring and designing 

various slides. 

(        ) 

15 To choose sorting, go to the toolbar, select Data, and then click 

Sort. 

(        ) 

16 Excel's common tools can be used for addition, subtraction, 

multiplication, and division. 

(        ) 

17 Excel allows you to manipulate numbers in the database by 

adding formulas. 

(        ) 

18 To add text in Excel cells, you must use a formula. (        ) 

19 To create a formula, you must first type "=" in the cell so that 

Excel knows you are creating a formula. 

(        ) 

20 You can add your favorite hobbies and favorite foods to your 

Excel database. 

 

(        ) 
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Choose the correct answer:  
1- All data must be managed in compliance with data protection laws .............. 

a- Egyptian                   b- Japanese.                       c - European 

 Changing and analyzing data in a database is ........ to meet the needs of users  

a. Difficult                      b. Easy                               c. Complex 

2- .................... can be used to collect data and information about people, 

places or things 

a - Paint program             b- Photo program              c - Database 

3- A teacher can use a database that includes information about ...................... 

a- his students                    b- street children                c- politicians   

4- Microsoft ........................ can be used to create a database   

a- Access                            b- Excel                                 c- Word   

5- To type the column headings and field names to be added, click on ............. 

a- A1, B1 and C1                 b- Student Name                    c- ID Number 

6- Sorting, adding, subtracting, dividing, and multiplying are tools of ............. 

           a- PowerPoint                   b- Word                                   c- Excel 

7- To choose sorting, you have to choose ................... from the toolbar. 

           a - design                          b – data                                  c - font type 

8- Excel allows you to deal with numbers in the database by adding ............. 

         a- Formulas                      b- Slide                                      c- Color 

9- To create a formula, you must first type ......................... 

           a. ???                                  b. :<:                                              C- "="  
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Put ( √ ) or ( X ) 

1 You can use PowerPoint to help you plan projects. (        ) 

2 PowerPoint allows you to share information with others   (        ) 

3 Sharing information via text and images is one of the things that 

PowerPoint allows. 

(        ) 

4  Videos, animations, and infographics are visuals that are not 

allowed to be shared through PowerPoint. 

(        ) 

5 To make your presentation more engaging, you can add some 

visuals such as a video or images. 

(        ) 

6  Presenting plain text without additional visuals can lead to a 

less engaging presentation. 

(        ) 

7 A flowchart is not a presentation tool. (        ) 

8 A flowchart does not have specific steps, but a new one can be 

created by simply clicking on the Insert Text tab. 

(        ) 

9 You can create a flowchart by clicking on the Insert tab, clicking 

on Choose Drawing, then the menu, and following the steps 

down to the text and selecting the color you want.  

(        ) 

10 Flowcharts allow you to change colors using styles. (        ) 

11 When presenting in front of an audience, you need to speak 

quickly. 

(        ) 

Lesson 6 Creating digital project 
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12 The introduction of the topic is an important part of your 

presentation.  

(        ) 

13 You should read directly from the content of the presentation 

without having to read it beforehand  

(        ) 

14 Be sure to refer to the different sections of the flowchart while 

presenting the information  

(        ) 

15 Presentations can be used to solve a problem or discuss an issue  (        ) 

Choose the correct answer:  

The ............................ program can create presentations to share information 

with others.   

A. PowerPoint.                       b - Painter.                                     C - camera 

2- Visualizations can be added to presentations such as videos, animations, 

and ................. 

a- Device settings                    b- Operating system                    c- Graphics 

3- PowerPoint works on ............... the scientific material presented and 

communicates it better than regular texts  

a - Complexity                      b - Difficulty                                 c- Simplification 

4- ............... can be used In conceptualizing, planning and presenting a task or 

project 

a. Flowcharts                             b. Facebook                          c. Video games 

5- To create a flowchart, you must first click on ................ from the Insert tab.   

a- Smart Art                              b- List                                               c- OK 
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6- To choose a flowchart you want to use, review the description at ............... 

a. References                          b. Input menu                           c. Dialog box 

7- You can choose the desired color by clicking Change Color from .................  

a- Illustrator                            b- Smar Art Design                     c- Start Menu 

8- When giving your presentation, you should speak ................. 

a. Very slowly                             b. Quickly                                 c. Confidently 

9- Start with .................... To explain and clarify the purpose of the 

presentation to the audience. 

a- Conclusion of the topic              b- Introduction                    c- Random way 

10. practicing in advance to read the content of the presentation before 

presenting it to the audience is ................... 

a. Important                                    b. Unnecessary                     c. Waste of time 
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Put ( √ ) or ( X ) 

1 Ms. Sonika Manandhar is a gaming technology entrepreneur. (  X   ) 

2 Ms. Sonika Manandhar is a National Geographic Explorer from 

the Republic of Congo 

(  X  ) 

3 Ms. Sonika Manandhar is known as one of the leading scientists 

in the educational gaming industry. 

(  X  ) 

4  Singularity University is affiliated with NASA in California. (  √   ) 

5 Ms. Manandhar wanted to use her knowledge to improve the 

local environment in Nepal. 

(  √   ) 

6  Increasing the amount of carbon emissions helps to improve the 

local and natural environment. 

(  X  ) 

7 The use of electric buses can reduce the rate of carbon 

emissions. 

(  √   ) 

8 Most of the bus drivers in Kathmandu are young people. (  X  ) 

9 Ms. Sonika Manandhar worked for the fintech company Aloi 

without co-founding it.  

(  X  ) 

10 Aloi helps people use financial services. (  √   ) 

11 Women drivers in Nepal can modernize their old buses by 

taking out loans from Aloy. 

(  √   ) 

12 The buses can be modernized with water-based batteries so that 

they last longer. 

(  X  ) 

 

Lesson 1 Explorer in action 
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13 Drivers can only repay their loans hand in hand. (  X  ) 

14 Aloi's loan process is faster and easier than most current bank 

loan processes. 

(  √   ) 

15 Only when the loan is approved can the driver receive a digital 

code that she can use with authorized vendors. 

(  √   ) 

16 The driver must pay all her debts to the mall at once from the 

profits in the month following the purchase. 

(  X  ) 

17 The driver can follow up on all her transactions through text 

messages without having to use the internet. 

(  √   ) 

18 The platform has nothing to do with the financiers' business as 

it cannot report on how the loans are spent. 

(  X  ) 

19 Passengers can schedule their trips through the company's 

website. 

(  √   ) 

20 Passengers can complete their financial transactions using 

digital tokens or mobile wallets. 

(  √   ) 

21 Egypt has not contributed to environmental conservation 

activities or any environmental conferences. 

(  X  ) 

22 Egypt has launched the first home-made electric car in the 

framework of adopting a green economy. 

(  √   ) 

23 The locally-made electric car launched by Egypt can 

accommodate 9 people and travel at a maximum speed   

(  X  ) 

24 Ms. Sonika Manandhar uses her Instagram account to spread 

awareness of the benefits of small green business owners 

(  √   ) 
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Choose the correct answer:  

1-Ms. Sonika Manandhar is a .................... technology entrepreneur   

A. Financial                      B. space.                C. Engineering equipment.   

2- Ms. Sonika Manandhar is a National Geographic explorer from the 

Republic of .................. 

A - Nepal                B - Dominican Republic            C - China 

3- "Sonika Manandhar" was interested in the field of ...................... 

A - Art                    B - Engineering                          C - Medicine 

4- She studied ....................... robotics and artificial intelligence at Singularity 

University. 

A- Big Kenner                    B- Mojos                        C- Sonika Manandhar 

5- NASA's Singularity University is located in ...................   

A- California                      B- Egypt                          C- France 

6- Sonika Manandhar wanted to utilize her knowledge of ............. the local 

environment by minimizing the rate of carbon emissions 

 A- improving                               B-  Destroy                       C- Optimize   

7- Sonika Manandhar noted that using ...............              may reduce the rate 

of carbon emissions. 

A- Electric minibuses      B- Coal minibuses        C- Natural gas trains    

Sonika Manandhar noticed that most of the car drivers in Nepal's capital 

................. are women. 

A. California                   B- Singularity                  C. Kathmandu 
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9- In 2019, Ms. Manandhar co-founded the fintech company ................. 

A- Amazon                       B- Aloi                             C- Google 

10 - Aloi helps women minibus drivers in Nepal access ................ low-interest 

loans. 

a. Loans                             b. Prizes                                    c. Rewards 

11- Aloi helps improve the environment by helping electric bus drivers to 

 purchase and modernize buses by providing them with long-lasting 

.................. 

a-Tools and equipment     b. Natural gases       c. Lithium-ion batteries 

12. Electric bus drivers receive and repay bank loans through ...................  

a. Direct bank transactions          b. Company platform            c. Mailboxes 

13- The electric bus driver receives .............. upon loan approval which she 

uses when dealing with authorized suppliers. 

a. Loan                         b. Card                                c. Digital code  

14- The electric bus driver repays her debt to the financier ................ from the 

profits she makes from her business. 

a. Monthly                   b. Daily                                 c. Yearly  

15- All financial transactions when purchasing electric buses are done 

through ................. 

a. Text messages                b. Whatsapp messages                  c. Emails  

16-It is .................. for Passengers to schedule their trips through the 

company's website. 

A. Impossible                 B. Possible                 C. Not available 
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17- Passengers can pay for the flight using digital tokens or ................ mobile 

phone. 

a. wallet                      b. whatsapp on                   C. Photo App 

18- As part of Egypt's adoption of green economy strategies, it launched the 

first .................. homemade. 

A - electric trains                   B – airplanes                         C - electric cars 

19- The electric car launched by Egypt to preserve the environment can 

accommodate nine people and travel at a maximum speed of .......... 

kilometers / hour. 

A- 60                         B- 90                                      C- 120 

20- The price of the electric car launched by Egypt is expected to be 

.................. for the Egyptian market. 

A- Unsuitable                    B- Unacceptable                          C- Suitable                                                               

 

 

Put ( √ ) or ( X ) 

1 The operating system (OS) manages computer functions and 

runs programs and hardware. 

(  √   ) 

2 The operating system is of no importance to your computer  (  X   ) 

3 The operating system allows the user to communicate with the 

computer easily. 

(  √   ) 

Lesson 2 Operating systems and software 
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4  The operating system coordinates and manages the 

communication between your hardware and software. 

(  √   ) 

5 The operating system has nothing to do with the requirements 

of different computer programs. 

(  X   ) 

6  Your computer will not be able to function without the 

operating system. 

(  √   ) 

7 The CPU, memory, and storage are components of a computer. (  √   ) 

8 A new operating system must be installed on the computer when 

you buy it because it is not supplied with it. 

(  X   ) 

9 Microsoft Windows is often used in schools on computers.  (  √   ) 

10 Macintosh computers use the macOS operating system. (  √   ) 

11 macOS is generally inexpensive as schools use it. (  X   ) 

12 Smartphones and tablets use Microsoft Windows operating 

systems. 

(  X   ) 

13 You can change operating system settings using the System 

Settings control. 

(  √   ) 

14 All operating system settings have the same names and 

appearances. 

(  X   ) 

15 In mac OS, the settings are called System Preferences. (  √   ) 

16 The settings in IOS are called Control Panel. (  X   ) 

17 Hardware or software settings in the Control Panel cannot be 

modified. 

(  X   ) 

18 You can add a new wireless printer to your computer, but it 

cannot be removed from your computer. 

(  X   ) 
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19 Changes you make in Control Panel are automatically applied 

to other programs on your computer. 

(  √   ) 

20 Some programs are automatically downloaded and allowed to 

be used immediately. 

(  √   ) 

21 To remove a program from your Windows machine, open 

Control Panel and then remove the program directly without 

following specific steps. 

(  X   ) 

22 Programs installed on Android devices cannot be removed. (  X   ) 

23 The operating system is an essential part of the programs on 

computers. 

(  √   ) 

Choose the correct answer:  

1-The operating system manages ....................  computer functions, running 

programs and hardware.   

a- os.                           b- mac.                                                    c- macintosh 

2- The most important program on your computer is .................. 

a. Word                      b. Operating system                             c. Paint 

3- The operating system coordinates communication between your devices 

and ......................... 

a. your friends                  b. your contacts                        c. your programs 

4- Most computers and laptops have a pre-loaded operating system 

................... 

a- Microsoft Windows               b- macOS                                     c- IOS   
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5- Smartphones and tablets use different operating systems such as Android 

and ...................   

Microsoft Windows                 b- macOS                               c- IOS   

6- You can change the operating system settings using the ......................... 

control 

a. Self              b. Selecting travel modes                 c. System Settings 

7- System settings have several different names and appearances depending 

on the ................. you are using. 

a- Operating system          b- Phone type             c- Device manufacturer 

8- Device settings in iOS are called ..................... 

A - Control Panel            B - Control Center         C - System Preferences 

9- You can locate ................ by typing Control Panel in the search box in the 

taskbar. 

a. Control Panel             c. PowerPoint                    d. Google 

10- To add a new wireless printer, select Hardware & Sound, then ............., 

then select the printer you want after the device searches for it. 

b. Clear data             b. Delete device                    c. Add device 

11. Changes you make in the Control Panel ............... are applied to other 

programs on your computer 

a. Manually            b. Automatically            c. With a specific physical tool   

12. You can drag and drop the font file you want from the font library 

installed on your computer located in .............  

a. Downloads folder           b. Hardware and Sound         c. Media and Printers 
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13. Programmers try to improve the graphical interface of the control panel 

with each version of Windows that comes out with ................. 

A. An updated operating system                           B. The same operating system 

C. A type of computer  

14- When you connect a new printer to a computer, ..................... downloads 

the appropriate software so you can use it right away. 

a- Windows                                    b- macOS                              c- IOS 

15- You can ....................... the program by clicking the right mouse button 

and then uninstalling 

a. Put                              b. Add                                           c. Delete  

16- To uninstall a program from .................., you can open the App Store, click 

on the profile icon, then click on Manage Applications and Devices, then 

Manage, hold down the name of the application you want to remove, then 

click on Uninstall. 

A- Android                                 B- Windows                             C- Microsoft 

 

 

Put ( √ ) or ( X ) 

1 Microsoft Word is by far the most reliable tool for writing 

reports and sharing information. 

(  √   ) 

2 You can write reports using the Microsoft Access application 

and use its various tools  

(  X   ) 

3 To choose a specific layout, click on the Layout and Input tabs. (  √   ) 

Lesson 3 Writing and sharing reports 
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4  Microsoft Word includes formatting tools that allow the user to 

print text in italic or bold formats. 

(  √   ) 

5 Microsoft Word tools do not allow you to put headings or create 

tables. 

(  X   ) 

6  Some of the tasks that Microsoft Word tools can perform are 

inserting images, hyperlinks, and footnotes. 

(  √   ) 

7 Previewing the initial document before saving or printing it is 

allowed in Microsoft Word. 

(  √   ) 

8 WhatsApp is a messaging service for exchanging ideas and 

sharing information. 

(  √   ) 

9 WhatsApp does not help in providing feedback, especially when 

working on a group project.  

(  X   ) 

10 Text messaging does not allow you to send audio and video 

messages and images. 

(  X   ) 

11 Text messages or photos can only be sent via WhatsApp to one 

person. 

(  X   ) 

12 WhatsApp is a very expensive service to use. (  X   ) 

 

13 Encrypting messages sent in WhatsApp is one of the good 

features of the application. 

(  √   ) 

14 WhatsApp services can be used from any device and without 

being restricted to a location. 

(  √   ) 

15 You can use the design elements in Microsoft Word to increase 

the professionalism of your report  

(  √   ) 
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Choose the correct answer: .    

1.Reports can be written using Microsoft………………   

a-Excel.                       b. PowerPoint.                                  c. Word 

2.To choose a specific layout, you can click on ............... and enter 

a. Layout                    b. Home page                                 c. References 

3.Microsoft's ................. program includes the ability to print italicized or 

capitalized words 

a. Word                       b. Access                          c. PowerPoint 

4.............. is one of Microsoft Word's formatting tools  

a. Footnotes                   b. Drawing                       c. Adding slides 

5.You can use messaging services such as .....................   

a. WhatsApp                   b. Excel                             c. Word   

6.Feedback from colleagues and teachers can be requested through ................ 

 a. WhatsApp                   b. Photos                          c. System Settings 

7.WhatsApp messages allow sending messages................. in a single 

conversation 

a. Individual                      b. Group                        c. Individual and group 

8.WhatsApp messages are characterized as .................... . 

a. Free                               b. Expensive                    c. Moderately priced 

9.No one but the recipient of the message can read it, a feature of WhatsApp 

called ................. 

a. Non-privacy                 b. Encryption                    c. Violations 
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10.WhatsApp messaging services can be used on an Android or Apple               

device ............. 

a. Unlimited                  b. Time-limited                    c. At a higher cost    

 

Put ( √ ) or ( X ) 

1 You can use office programs and create presentations to express 

your opinions and ideas. 

(  √   ) 

2 Make your presentations interesting and engaging by using the 

right design.  

(  √   ) 

3 Microsoft PowerPoint is a text editing application only. (  X   ) 

4  Animation options are available to add motion to the sentences 

and words on the slides. 

(  √   ) 

5 Microsoft PowerPoint does not help to create presentations in 

which you can express your ideas.  

(  X   ) 

6  All Microsoft PowerPoint tools are complex and require special 

skills. 

(  X   ) 

7 You can effectively communicate your idea by using the tools to 

create engaging visuals that will grab the attention of your 

viewers. 

(  √   ) 

8 You can review your presentation through the editing tab in 

review mode. 

(  √   ) 

Lesson 4 Creating  a presentation 
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9 You can save the file and maintain its format by saving it in 

Word.  

(  X   ) 

10 PowerPoint does not offer the option to customize the slide size. (  X   ) 

11 The tools in the Design tab help attributes and variables to 

choose the style of your presentation. 

(  √   ) 

12 The Insert tab allows you to add an image, shape, or text box. (  √   ) 

 

13 Images can be loaded from files on the computer only when an 

image is inserted into the presentation. 

(  X   ) 

14 You can preview the presentation for the last time by pressing 

the Print button. 

(  √   ) 

15 The PowerPoint presentation should not exceed 10 slides and 20 

minutes and should not use a font type smaller than 30 points  

(  √   ) 

Choose the correct answer:  

1- You can create presentations through the Microsoft program ........................   

a- Word.                       b - PowerPoint.                      c - Access 

2- Using the right ............ makes presentations more interesting and 

attractive. 

a. Design                       b. Device                                 c. Mouse 

3- Microsoft PowerPoint includes tools .............. and writing for drafting texts. 

a - Maintenance               b - Engineering                  c – Drawing 
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4- Options are available ..................... to add movement to sentences and 

words on slides 

a - do not allow                     b – prohibit                      c- allow 

5- PowerPoint includes tools .................... that help users create engaging 

materials for viewers. 

b. Difficult                              b. Complex                       c. Easy  

6- To save the file before printing to preserve its formatting, click on ............. 

a- Save the file as - pdf option           b- Delete the file           c- Layout 

7- You can review the presentation and make changes in review mode by 

clicking on ................... 

a- Insert an image             b- Edit in review mode            c- Add a table 

8- The slide size is chosen by clicking on the ........................ tab. 

a- Input- Text box          b- Type size             c- Design- Slide size 

9- The style and position of the text can be changed by clicking on .................... 

a- Insert                         b- Design- Themes                  c- File 

10- When writing the message on PowerPoint, you must observe the rule of 

................ when it comes to text size 

a- 10/20/30                    b- Security                                c- Device 

11- The number 10 in the 10/20/30 rule refers to ...................... 

a. Presentation time          b. Number of slides                c. Font size 

12- The number 20 in the 10/20/30 rule refers to ...................... 

a. Number of slides          b. Font size                c. Display time   
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13- The number 30 in the 10/20/30/30 rule refers to the lowest ......................  

a- Font size              b- Display time                    c- Number of slides 

14- Images can be added by clicking on the ...................... tab 

a- Insert Image                  b- File- Print              c- Insert Text Box   

15- You can print the file by clicking on .................... 

a- File- Print                       b- Insert                      +c- Design 

 

Put ( √ ) or ( X ) 

1 To be able to analyze your results and make decisions, you need 

to organize the information you collect about an issue. 

(  √   ) 

2 All data must be managed in compliance with European data 

protection laws  

(  X   ) 

3 Databases store a limited amount of data and information in a 

computer system  

(  X   ) 

4  Data can be easily analyzed or changed to meet the needs of 

users. 

(  √   ) 

5 A database does not allow the collection of data or information 

about people or places. 

(  X   ) 

6  Teachers can use databases to collect information about their 

students. 

(  √   ) 

7 Companies use databases to record information about their 

employees. 

(  √   ) 

Lesson 5 Creating a database 
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8 Microsoft Word is used to create a database. (  X   ) 

9 To type the column headings and field names to be added, click 

Class Name    

(  X   ) 

10 ID Number is used to type the correct identification number. (  √   ) 

11 To add a column to a database, right-click and choose Insert 

Column. 

(  √   ) 

12 Type the class name in the Class Name column. (  √   ) 

 

13 Excel automatically formats numbers and dates as you type 

them. 

(  √   ) 

14 Some common Excel tools include coloring and designing 

various slides. 

(  X   ) 

15 To choose sorting, go to the toolbar, select Data, and then click 

Sort. 

(  √   ) 

16 Excel's common tools can be used for addition, subtraction, 

multiplication, and division. 

(  √   ) 

17 Excel allows you to manipulate numbers in the database by 

adding formulas. 

(  √   ) 

18 To add text in Excel cells, you must use a formula. (  X   ) 

19 To create a formula, you must first type "=" in the cell so that 

Excel knows you are creating a formula. 

(  √   ) 

20 You can add your favorite hobbies and favorite foods to your 

Excel database. 

 

(  √   ) 
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Choose the correct answer:  
1- All data must be managed in compliance with data protection laws .............. 

a- Egyptian                   b- Japanese.                       c - European 

 Changing and analyzing data in a database is ........ to meet the needs of users  

a. Difficult                      b. Easy                               c. Complex 

2- .................... can be used to collect data and information about people, 

places or things 

a - Paint program             b- Photo program              c - Database 

3- A teacher can use a database that includes information about ...................... 

a- his students                    b- street children                c- politicians   

4- Microsoft ........................ can be used to create a database   

a- Access                            b- Excel                                 c- Word   

5- To type the column headings and field names to be added, click on ............. 

a.A1, B1 and C1                 b- Student Name                    c- ID Number 

6- Sorting, adding, subtracting, dividing, and multiplying are tools of ............. 

    a- PowerPoint                   b- Word                                   c- Excel 

7- To choose sorting, you have to choose ................... from the toolbar. 

           a - design                          b – data                                  c - font type 

8- Excel allows you to deal with numbers in the database by adding ............. 

         a- Formulas                      b- Slide                                      c- Color 

9- To create a formula, you must first type ......................... 

           a. ???                                  b. :<:                                              C- "="  
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Put ( √ ) or ( X ) 

1 You can use PowerPoint to help you plan projects. (  √   ) 

2 PowerPoint allows you to share information with others   (  √   ) 

3 Sharing information via text and images is one of the things that 

PowerPoint allows. 

(  √   ) 

4  Videos, animations, and infographics are visuals that are not 

allowed to be shared through PowerPoint. 

(  X   ) 

5 To make your presentation more engaging, you can add some 

visuals such as a video or images. 

(  √   ) 

6  Presenting plain text without additional visuals can lead to a 

less engaging presentation. 

(  √   ) 

7 A flowchart is not a presentation tool. (  X   ) 

8 A flowchart does not have specific steps, but a new one can be 

created by simply clicking on the Insert Text tab. 

(  X   ) 

9 You can create a flowchart by clicking on the Insert tab, clicking 

on Choose Drawing, then the menu, and following the steps 

down to the text and selecting the color you want.  

(  √   ) 

10 Flowcharts allow you to change colors using styles. (  √   ) 

11 When presenting in front of an audience, you need to speak 

quickly. 

(  X   ) 

Lesson 6 Creating digital project 
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12 The introduction of the topic is an important part of your 

presentation.  

(  √   ) 

13 You should read directly from the content of the presentation 

without having to read it beforehand  

(  X   ) 

14 Be sure to refer to the different sections of the flowchart while 

presenting the information  

(  √   ) 

15 Presentations can be used to solve a problem or discuss an issue  (  √   ) 

Choose the correct answer:  

The ............................ program can create presentations to share information 

with others.   

A. PowerPoint.                       b - Painter.                                     C - camera 

2- Visualizations can be added to presentations such as videos, animations, 

and ................. 

a- Device settings                    b- Operating system                    c- Graphics 

3- PowerPoint works on ............... the scientific material presented and 

communicates it better than regular texts  

a - Complexity                      b - Difficulty                                 c- Simplification 

4- ............... can be used In conceptualizing, planning and presenting a task or 

project 

a. Flowcharts                             b. Facebook                          c. Video games 

5- To create a flowchart, you must first click on ................ from the Insert tab.   

a- Smart Art                              b- List                                               c- OK 
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6- To choose a flowchart you want to use, review the description at ............... 

a. References                          b. Input menu                           c. Dialog box 

7- You can choose the desired color by clicking Change Color from .................  

a- Illustrator                            b- Smar Art Design                     c- Start Menu 

8- When giving your presentation, you should speak ................. 

a. Very slowly                             b. Quickly                                 c. Confidently 

9- Start with .................... To explain and clarify the purpose of the 

presentation to the audience. 

a- Conclusion of the topic              b- Introduction                    c- Random way 

10. practicing in advance to read the content of the presentation before 

presenting it to the audience is ................... 

a. Important                                    b. Unnecessary                     c. Waste of time 
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Put ( √ ) or ( X ) 
1 When presenting in front of an audience, speak quickly (      ) 

2 Microsoft PowerPoint is a text editing application only (      ) 

3 Microsoft Word includes formatting tools that allow the user to print 

text in italicized or bolded formats.  

(      ) 

4 The operating system has nothing to do with the requirements of 

different computer programs 

(      ) 

5 Ms. Sonika Manandhar wanted to use her knowledge to improve 

       the local environment in Nepal 

(      ) 

Choose the correct answer:  

1. The most important program on your computer is .................. 

             a. Word                     b. Operating system                     c. Paint 

2. You can locate ................ by typing control panel in the search box in the 

taskbar. 

            a. Control Panel                b. PowerPoint                     c. Google 

3. Reports can be written using Microsoft.   

            a. Excel.                             b. PowerPoint.                      c- Word 

4-To save the file before printing to preserve its formatting, click on ............. 

              a- Save the file as - pdf option               b- Delete the file       c- Layout 

5- Excel allows you to deal with numbers in the database by adding ............. 

a- Formulas                        b- slide                                   c- color 
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Put ( √ ) or ( X ) 

1 The operating system doesn't matter in your computer (      ) 

2 Macintosh computers use the macOS operating system. (      ) 

3 Text messaging does not allow sending messages, audio images, and videos. (      ) 
4 You can save the file and maintain its format by saving it in Word. (      ) 

5  Microsoft Word is used to create a database   (      ) 

Choose the correct answer:  

1- PowerPoint works to ............... the scientific material presented and 

communicates it better than regular texts  

          A - Complexity                       B - Difficulty             C - Simplification 

2- To type the column headings and field names to be added, click on ........... 

          A- A1, B1 and C1                  B- Student Name           C- ID Number 

3- The number 20 in the 10/20/30 rule refers to ...................... 

           A- Number of slides               B- Font size                   C- Display time  

 4 -WhatsApp messages allow sending messages ................. in a single 

conversation 

             A - individual                          B – group          C - individual and group 

5- Programmers try to improve the graphical interface of the control panel 

with each version of Windows that comes out. 

A. an updated operating system                          B. the same operating system 

C. a different type of computer 
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Exam Sample (1)

Put ( √ ) or ( X ) 
1 When presenting in front of an audience, speak quickly (  X   ) 

2 Microsoft PowerPoint is a text editing application only (  X   ) 

3 Microsoft Word includes formatting tools that allow the user to print 

text in italicized or bolded formats.  

(  √   ) 

4 The operating system has nothing to do with the requirements of 

different computer programs 

(  X   ) 

5 Ms. Sonika Manandhar wanted to use her knowledge to improve 

       the local environment in Nepal 

(  √   ) 

Choose the correct answer:  

1. The most important program on your computer is .................. 

             a. Word                     b. Operating system                     c. Paint 

2. You can locate ................ by typing control panel in the search box in the 

taskbar. 

            a. Control Panel                b. PowerPoint                     c. Google 

3. Reports can be written using Microsoft.   

            a. Excel.                             b. PowerPoint.                      c- Word 

4-To save the file before printing to preserve its formatting, click on ............. 

              a- Save the file as - pdf option               b- Delete the file       c- Layout 

5- Excel allows you to deal with numbers in the database by adding ............. 

a- Formulas                        b- slide                                   c- color 
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Exam Sample (2)

Put ( √ ) or ( X ) 

1 The operating system doesn't matter in your computer (  X   ) 

2 Macintosh computers use the macOS operating system. (  √   ) 

3 Text messaging does not allow sending messages, audio images, and videos. (  √   ) 
4 You can save the file and maintain its format by saving it in Word. (  X   ) 

5  Microsoft Word is used to create a database   (  X   ) 

Choose the correct answer:  

1- PowerPoint works to ............... the scientific material presented and 

communicates it better than regular texts  

          A - Complexity                       B - Difficulty             C - Simplification 

2- To type the column headings and field names to be added, click on ........... 

          A- A1, B1 and C1                  B- Student Name           C- ID Number 

3- The number 20 in the 10/20/30 rule refers to ...................... 

           A- Number of slides               B- Font size                   C- Display time  

 4 -WhatsApp messages allow sending messages ................. in a single 

conversation 

             A - individual                          B – group          C - individual and group 

5- Programmers try to improve the graphical interface of the control panel 

with each version of Windows that comes out. 

A. an updated operating system                          B. the same operating system 

C. a different type of computer 
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Put ( √ ) or ( X ) 
1 When presenting in front of an audience, speak quickly (      ) 

2 Microsoft PowerPoint is a text editing application only (      ) 

3 Microsoft Word includes formatting tools that allow the user to print 

text in italicized or bolded formats.  

(      ) 

4 The operating system has nothing to do with the requirements of 

different computer programs 

(      ) 

5 Ms. Sonika Manandhar wanted to use her knowledge to improve 

       the local environment in Nepal 

(      ) 

Choose the correct answer:  

1. The most important program on your computer is .................. 

             a. Word                     b. Operating system                     c. Paint 

2. You can locate ................ by typing control panel in the search box in the 

taskbar. 

            a. Control Panel                b. PowerPoint                     c. Google 

3. Reports can be written using Microsoft.   

            a. Excel.                             b. PowerPoint.                      c- Word 

4-To save the file before printing to preserve its formatting, click on ............. 

              a- Save the file as - pdf option               b- Delete the file       c- Layout 

5- Excel allows you to deal with numbers in the database by adding ............. 

a- Formulas                        b- slide                                   c- color 
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Match From (A) the suitable number From (B) 

A B 

1 PowerPoint 
 

You can.  Write reports using it. 

2 Word                                                          
 

You can request feedback from colleagues 

and teachers through it 

3 System settings 
 

 You can create presentations with it  

4 Database 
 

 To create a flowchart, you must first click on 

..................... from the Insert tab.   

5 Smart Art                    
 

To collect data and information about people, 

places, or things 
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Put ( √ ) or ( X ) 

1 The operating system doesn't matter in your computer (      ) 

2 Macintosh computers use the macOS operating system. (      ) 

3 Text messaging does not allow sending messages, audio images, and videos. (      ) 
4 You can save the file and maintain its format by saving it in Word. (      ) 

5  Microsoft Word is used to create a database   (      ) 

Choose the correct answer:  

1- PowerPoint works to ............... the scientific material presented and 

communicates it better than regular texts  

          A - Complexity                       B - Difficulty             C - Simplification 

2- To type the column headings and field names to be added, click on ........... 

          A- A1, B1 and C1                  B- Student Name           C- ID Number 

3- The number 20 in the 10/20/30 rule refers to ...................... 

           A- Number of slides               B- Font size                   C- Display time  

 4 -WhatsApp messages allow sending messages ................. in a single 

conversation 

             A - individual                          B – group          C - individual and group 

5- Programmers try to improve the graphical interface of the control panel 

with each version of Windows that comes out. 

A. an updated operating system                          B. the same operating system 

C. a different type of computer 
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Choose the correct answers using the words between 

brackets 

(Word - System Settings - Database  - Smart Art  -Power point  ) 

1.Reports can be written using .............. 

2.You can create presentations with Microsoft ........................   

3.Feedback from peers and teachers can be solicited through the  

4.You can use .................... to collect data and information about people, 

places, or things 

5.To create a flowchart, first click on ..................... from the Insert tab.   
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Answers

Put ( √ ) or ( X ) 
1 When presenting in front of an audience, speak quickly (  X   ) 

2 Microsoft PowerPoint is a text editing application only (  X   ) 

3 Microsoft Word includes formatting tools that allow the user to print 

text in italicized or bolded formats.  

(  √   ) 

4 The operating system has nothing to do with the requirements of 

different computer programs 

(  X   ) 

5 Ms. Sonika Manandhar wanted to use her knowledge to improve 

       the local environment in Nepal 

(  √   ) 

Choose the correct answer:  

1. The most important program on your computer is .................. 

             a. Word                     b. Operating system                     c. Paint 

2. You can locate ................ by typing control panel in the search box in the 

taskbar. 

            a. Control Panel                b. PowerPoint                     c. Google 

3. Reports can be written using Microsoft.   

            a. Excel.                             b. PowerPoint.                      c- Word 

4-To save the file before printing to preserve its formatting, click on ............. 

              a- Save the file as - pdf option               b- Delete the file       c- Layout 

5- Excel allows you to deal with numbers in the database by adding ............. 

a. Formulas                        b- slide                                   c- color 
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Match From (A) the suitable number From (B) 

A B 

1 PowerPoint 
2 

You can.  Write reports using it. 

2 Word                                                          
3 

You can request feedback from colleagues 

and teachers through it 

3 System settings 
1 

 You can create presentations with it  

4 Database 
4 

 To create a flowchart, you must first click on 

..................... from the Insert tab.   

5 Smart Art                    
5 

To collect data and information about people, 

places, or things 
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Put ( √ ) or ( X ) 

1 The operating system doesn't matter in your computer (  X   ) 

2 Macintosh computers use the macOS operating system. (  √   ) 

3 Text messaging does not allow sending messages, audio images, and videos. (  √   ) 
4 You can save the file and maintain its format by saving it in Word. (  X   ) 

5  Microsoft Word is used to create a database   (  X   ) 

Choose the correct answer:  

1- PowerPoint works to ............... the scientific material presented and 

communicates it better than regular texts  

          A - Complexity                       B - Difficulty             C - Simplification 

2- To type the column headings and field names to be added, click on ........... 

          A- A1, B1 and C1                  B- Student Name           C- ID Number 

3- The number 20 in the 10/20/30 rule refers to ...................... 

           A- Number of slides               B- Font size                   C- Display time  

 4 -WhatsApp messages allow sending messages ................. in a single 

conversation 

             A - individual                          B – group          C - individual and group 

5- Programmers try to improve the graphical interface of the control panel 

with each version of Windows that comes out. 

A. an updated operating system                          B. the same operating system 

C. a different type of computer 
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Choose the correct answers using the words between 

brackets 

(Word - System Settings - Database  - Smart Art  -Power point  ) 

1.Reports can be written using Word 

2.You can create presentations with Microsoft Power point   

3.Feedback from peers and teachers can be solicited through the System 

Settings 

4.You can use Database  to collect data and information about people, 

places, or things 

5.To create a flowchart, first click on Smart Art  from the Insert tab.   

 

 

 


